
Computer -  5 

1. Computer Software 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. It is the most important software without which you cannot work on a 

computer system. 

(i) Operating System  [  ✓ ] 

(ii) Utility Software 

(iii) Antivirus 

 

b. It is controls the internal computer operation. 

(i) System software  [  ✓ ] 

(ii) Operating System 

(iii) Utility Software 

 

c. It is a computer program that may disrupt the normal functioning of 

your computer. 

(i) Virus    [  ✓ ] 

(ii) Application Software 

(iii) Utility Software 

 

d. This type of software allows you to create and edit images. 

(i) Graphics software  [  ✓ ] 

(ii) Multimedia software 

(iii) Presentation software 

 

2. Fill in the blanks: 

Ans:    

a. It is a software program that lets you communicate with the computer. 

b. It is an important component that controls all other components of the 

computer system. 

c. DBMS is a software program that lets you store a large amount of 

data in an organized manner. 

d. An open source software is one which may be available free of cost. 

e. It serves as an interface between the user and the hardware. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  



a. A computer cannot run without an Operating System. : [ T ] 

b. Computer software is stored and executed  

 with the help of computer software. : [ F ] 

c. A DBMS can store details about the  

 customers, employees, products and so on. : [ T ] 

d. A computer system has many resources  

 such as CPU time, memory space and  

 I/O devices. : [ T ] 

e. A virus is a computer program that may  

 discreet the normal functioning of your  

 computer. : [ T ] 

 

4. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Word Processors (iv) MS Word  

b. Presentation Tool (iii) MS PowerPoint 

c. Spreadsheet Package (ii) MS Excel  

d. Business software (i) Payroll System 

 

5. Write the use of the following: 

Ans:    

a. Application Software : It enables user to complete tasks such as 

creating document, spreadsheets, 

databases, publications, sending e-mail, 

designing graphics, running business and 

even playing games. 

b. DBMS : A DBMS (Database Management System) 

can store details about the customers, 

employees, products and so on. Examples:  

Oracle, Access, FoxPro and Open 

Office.org Base.   

c. Multimedia Software : It allows us to combine images, text, 

sound, animations and videos to create 

interactive applications.  Examples:  

Adobe Director, Adobe Flash. 

d. DTP : DTP (Desktop Publishing Software) is 

used for creating designs, and layouts of 

books, journals, brochures, newspapers, 



etc. Examples:  Quark Xpress and Adobe 

InDesign. 

e. Software : Software is a set of programs that runs a 

computer system. Computer software is 

stored and executed with the help of 

computer hardware. Examples:  Operating 

System, Language Processor, Utility 

Software, Application Software. 

f. Antivirus Software : Antivirus Software program scans the disk 

for viruses and removes them.  Examples:  

Norton, Quick Heal, AVG Anti-Virus. 

6. Answer the following questions: 

a. What do you understand by Application Software? 

Ans: 

Application Software is a set of programs necessary to carry out 

operations for a specified application.  These are the programs 

written by programmers to enable computers to perform a 

specific task.  Various Application Software and their examples 

are given in the table below: 

Application Software Example 

Word Processor MS Word 

Presentation Tool MS PowerPoint 

Spreadsheet Package MS Excel, Lotus 123 

Database Management System 
Inventory Management, 

Payroll System 

Business Software 
Financial Accounting, Hotel 

Management, etc. 

 

b. What is the function of System Software? 

Ans: 

System Software controls the internal computer operations.  The 

function of System Software can be classified into four categories:  

1. Operating System (OS): 

An OS is a software which acts as an interface between user 

and computer.  It controls all other components of the 

computer.  Without an OS, a computer is of no use.  Some OS 

are Window, DOS, UNIX, etc. 



Basic functions OS performs are: 

1. It coordinates the working of various hardwares attached 

to computer system. 

2. It acts as a resource manager.  A computer has many 

resources like CPU time, memory space and I/O devices. 

3. OS lets us create and manage files and folders for storing 

information in a computer. 

2. Language Processor: 

Software is created by writing programs in computer languages.  

Main languages are C, C++, C# Python and Java.  A computer 

understands the machine language of 0 and 1.  A Language 

Processor is a software that translates a program in a computer 

language into the machine language so that it could be 

understood by computer. 

3. Utility Software: 

Utility Software contains those application programs that assist 

a computer by performing housekeeping functions lie backing 

up disk or scanning / cleaning viruses or arranging information.  

They ensure smooth functioning of a computer. 

4. Application Software: 

Application Software is a set of programs necessary to carry out 

operations for a specified application.  These are the programs 

written by programmers to enable computers to perform a 

specific task.  Various Application Software and their examples 

are given in the table below: 

 

c. Differentiate hardware and software. 

Ans: 

Difference between hardware and software is as follows: 

Hardware  : Physical parts of a computer are called 

Hardware.  We can see and touch all hardware 

parts.  Hardware can be classified into (i) Input 

Devices (ii) Processing unit and (iii) Output 

devices.  Hardware is the item used to define 

various parts of a computer.   

 

  Hardware devices are performers of commands 

given by software applications.  Some 

computer hardware devices are: 

1. Monitor 



2. CPU 

3. Mouse 

4. Keyboard 

 

Software : Computer software cannot be touched.  It can 

be seen in the form of icons (symbols) when 

installed in computer.  Software are programs 

written for hardware to work.  Examples are: 

1. Note Pad 

2. MS-Paint 

3. MS-Word 

4. MS-Excel, etc. 

 

d. Write any three functions of an Operating System? 

Ans: 

Three functions of an Operating System are: 

1. Operating System coordinates the working of various 

hardwares attached to computer system. 

2. Operating System acts as a resource manager.  A 

computer has many resources like CPU time, memory 

space and Input and Output devices. 

3. Operating System allows us create and manage files and 

folders for storing information in a computer. 

 

e. What is the use of Spreadsheet Software? 

Ans: 

Spreadsheet Software accepts data values in row and columns 

format to allow users to manipulate, calculate and analyze data 

in the desired manner. 

 

Examples of Spreadsheet Software are: 

1. Excel 

2. Lotus 1-2-3 

3. Open Office.org Calc. 

4. Spreadsheet Software 

Activity Time 

A. Write the names of the following: 

Ans: 

1. Picture 1st  : Linux 

2. Picture 2nd   : Access 2013 



3. Picture 3rd  : Excel 2013 

4. Picture 4th  : Word 2013 

5. Picture 5th  : Android 

6. Picture 6th  : Adobe Photoshop  

 

2. Formatting in Word  

Documents 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. What is called to make text slightly low on the line? 

(i) Subscript [  ✓ ] 

(ii) Superscript 

(iii) Both (i) and (ii) 

(iv) None of them 

 

b. Which group has Find button? 

(i) Editing [  ✓ ] 

(ii) Styles 

(iii) Font 

(iv) Paragraph 

 

c. How many columns can be created in one document? 

(i) Four 

(ii) Three 

(iii) Multiple [  ✓ ] 

(iv) Two 

 

d. Where can Footer be created? 

(i) Bottom of page [  ✓ ] 

(ii) Top of page 

(iii) Centre of page 

(iv) None of them 

 

2. Fill in the blanks: 

Ans:    

a. It is a software program that lets you communicate with the computer. 

b. It is an important component that controls all other components of the 

computer system. 



c. DBMS is a software program that lets you store a large amount of 

data in an organized manner. 

d. An open source software is one which may be available free of cost. 

e. It serves as an interface between the user and the hardware. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Zoom (+) button is used only to decrease  

 the size of page. : [ F ] 

b. Tab key is used to move the cursor at  

 certain spaces in a document. : [ T ] 

c. To copy the formatting effects of a piece  

 of text, we click on Format Painter. : [ T ] 

d. Page Margins can be set from top, bottom  

 and left, right of the page. : [ T ] 

e. Portrait or Landscape are net computer  

 terms. : [ T ] 

 

4. Answer the following questions: 

a. Write the use of Header and Footer options. 

Ans: 

A Header is the top margin of each page.  And Footer is the 

bottom margin of each page.   Headers and footers are useful 

for including material that we want to appear on every page of a 

document such as Name, Title of document or Page Numbers. 

 

We follow the following steps for creating Header and Footer: 

1. Click on the Insert tab on Ribbon. 

2. Click on Header or Footer.  The Built in Dialog Box 

displays. 

Now we select a style.  We choose the information that we wish 

to have in Header or Footer like Date, Time, Page Numbers, 

etc.  

 

b. Write some functions of Find and Replace button? 

Ans: 

Some functions of Find button are: 

1. We click on Home tab. 

2. Click on Find button in Editing group. 



3. In Find What box, we write text that we wish to search 

for. 

4. We do one of following: 

Click Find Next to find each instance of a word. 

Click on More to check or uncheck box for following: 

• Search All 

• Search Down 

• Search Up 

• Match Case Find Whole Words only. 

 

Some functions of Replace button are: 

1. Click on Replace on Home tab in Editing group. 

2. Click on Replace tab. 

3. In Find What box, write text that we wish to search for. 

4. In Replace with box, write the replacement text. 

5. After this, we must do as below: 

• Click on Find Next to find the next occurrence of 

text. 

• Click on Replace to replace an occurrence of text.  

• At last, click on Replace All to replace all 

occurrences of text. 

 

c. What is copy formatting? 

Ans: 

The user has to format the text after having written the same.  

The user can format text in the manner he wants.  If he likes 

another portion of document to have the same formatting, he 

can copy the formatting.  To copy formatting, the user follows 

these steps: 

1. Select text with formatting which user wishes to copy. 

2. Click Format Painter in Clipboard group on Home tab. 

The Mouse Pointer turns into a Paintbrush.  It looks 

strange. 

3. Apply the copied format by selecting text and clicking on 

it. 

4. Key Note: To apply format to more than one item, 

double-click on Format Painter button and 

apply the format. 

 



d. What do you understand by Subscript?  How will you apply it on the 

text? 

Ans: 

A Subscript is a character slightly below normal line of type.  It 

is usually smaller than rest of text. Subscript appears at or 

below baseline.  Subscripts are most often used in formulae, 

mathematical expressions and chemical compounds.   

 

We will Subscript on text in the following way: 

1. Select text that we wish to format as Subscript. 

2. Click on Subscript on Home tab in Font group. 

 

e. Write the steps to print a document? 

Ans: 

The steps to print a document are: 

1. Click on Office Button, point at Print and then Click on 

Print option.  Print Dialog box is displayed. 

2. Click on Drop-down arrow in Name box to select 

attached Printer. 

3. Enter number of copies in Number of Copies box. 

4. Click on OK to print the document. 

The print-out process is completed and print-out is taken. 

 

5. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Normal (v) The most common margin 

width.  

b. Indent (vi) The amount of space between 

the text and the page margin.  

c. Left tab stop (i) Sets the initial position of text.  

d. Center tab stop (ii) Sets the middle position of text.  

e. Right tab stop (iii) Sets the right end of text. 

f. A tab stop (iv) To jump the cursor. 

 

6. These are some commands.  They display on the Ribbon of Print 

Preview Tab.  Write their uses.  

Ans:    

COMMAND BUTTONS USES 



Zoom 

It opens the Zoom dialog box.  

We can set the zoom setting of 

the Print Preview. 

100% 
It displays the print preview at 

100%. 

One Page 

It zooms (increases / decreases 

the zoom setting) the document 

so that an entire page fits in the 

window. 

Page Width 

It zooms (increases / decreases 

the zoom setting) the document 

so that the width of the page 

matches the width of the 

window. 

Two Pages 

It zooms (increases / decreases 

the zoom setting) the document 

so that two pages fit the window. 

 

Activity Time 

Do it yourself. 

3. Tables in  

  MS-Word 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. Which of the following features adjusts column width automatically? 

(i) AutoFit [  ✓ ] 

(ii) Splitting 

(iii) Margin 

(iv) None of them 

 

b. What is a Table made up of? 

(i) Columns 

(ii) Rows 

(iii) Both (i) and (ii) [  ✓ ] 

(iv) None of them 

 

c. Split cells means to divide a cell into ………….. . 

(i) two cells 



(ii) many cells [  ✓ ] 

(iii) four cells 

(iv) eight cells 

 

2. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Shift key is used to move to reach last cell  

 in the table. : [ F ] 

b. A table is not made up of rows and  

 columns. : [ F ] 

c. We cannot insert 10 rows and 10 columns  

 in a table. : [ F ] 

d. We can create a table manually. : [ T ] 

 

3. Fill in the blanks: 

Ans:    

a. The intersection of a row and column is called a cell. 

b. We can use the Insert Table command to choose the table dimensions. 

c. Arrow keys allow us to move left, right, up and down. 

d. Click on Auto Fit to adjust table width automatically. 

e. The Formula command is found under the Table Tools tab. 

 

4. Answer the following questions: 

a. What do you mean by a Table? 

Ans: 

A Table is a grid of rows and columns that intersect to form 

cells.  It is easier to read or present information in Table Format 

than in paragraph format.   Using Word’s table feature, we can 

create a Table and insert text, pictures or another. 

 

b. How will you calculate the sum in a Table? 

Ans: 

We will calculate the sum in a Table by using SUM formula.  

Formula command is found under the Table Tools tab in the 

Data Group Layout tab.  It is done as follows: 

1. Select table cell where we want our result.  If cell is not 

empty, delete is contents. 

2. Click on Table Tools tab and then on Layout tab.  In the 

Data group, Click on Formula. 

3. Use the Formula dialog box to create the formula. 



Here we see that SUM (left) formula is already 

displayed.  

4. Click on OK button. 

 

c. How can you delete row(s) and column(s) in a Table? 

Ans: 

We can delete row(s) and column(s) in a Table by using the 

Layout tab from the table by following the given steps: 

Step 1 : Cursor should be placed in the table from where 

you want to delete a row / column. 

Step 2 : Click on the Layout tab.  

Step 3 : Click on Delete from the Rows and Column group.  

A menu will appear. 

Step 4 : Click on Delete Rows / Delete Columns from it.  

Entire Row / Column gets deleted. 

 

d. What is the use of Split Cells option? 

Ans: 

The use of Split Cells option is that we can divide a table cell 

into more cells.  It is reverse process of merging cells. Dividing 

up of a single cell into multiple cells is called Splitting Cell. 

 

There are following steps to split the cell: 

Step 1 : Click on the cell that is to be splitted. 

Step 2 : Click on the Layout tab.  

Step 3 : Click on Split Cells from Merge group.  

Step 4 : The Split Cells dialog box appears.  

 Indicate/specify the number of columns and 

rows into which you want to split the 

selected cell. 

Step 5 : Click on the OK. Cell gets split up. 

 

e. How will you change the column width? 

Ans: 

While working on a Table, the column width can be changed.  

We follow these steps for changing the column width: 

1. To change the column width to a specific measurement, 

click on a cell in the column that we want to resize. 

2. Click on Layout tab.  In the Cell Size group, click on the 

Width box.  Then specify the size we want. 



Activity Time 

Do it yourself. 

4. Learning MS  

Excel 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. It is also called a Spreadsheet in which we work. 

(i) Workarea 

(ii) Workpage 

(iii) Worksheet [  ✓ ] 

 

b. The intersection of a row and a column is called a 

……………………. . 

(i) box 

(ii) row 

(iii) cell  [  ✓ ] 

 

c. A formula always starts with an ……………………. . 

(i) Plus sign 

(ii) Minus sign 

(iii) Equal sign [  ✓ ] 

 

d. To quickly fill in several types of data series, we use 

……………………. . 

(i) AutoShape 

(ii) AutoArt 

(iii) AutoFill [  ✓ ] 

 

e. It is displayed when you select the text or right-click on it. 

(i) Menu Toolbar 

(ii) Mini Toolbar [  ✓ ] 

(iii) File Toolbar 

 

2. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Excel allows you to store, organize and  

 analyze information. : [ T ] 

b. A worksheet has 10,58,576 rows and  



 16,384 columns. : [ T ] 

c. A worksheet holds one or more workbooks. : [ T ] 

d. Numbers contain any combination of  

 numeric values from 0 to 9. : [ T ] 

e. Redo command is used to cancel the last  

 action done in the worksheet. : [ T ] 

 

3. Fill in the blanks: 

Ans:    

a. Worksheets are identified by letter left to right. 

b. Cell area is the place where you type your text. 

c. The File menu button contains the commands like New, Open, Save 

and Print. 

d. Ribbon has multiple tabs, each with several groups of commands. 

e. Formula is an equation that performs calculations in a cell. 

 

4. Write the answer in one or two words: 

Ans:    

a. The intersection of a row and a  

 column. : Cell 

b. Excel files are called. : Workbooks 

c. They are three in number when  

 you open an Excel file. : Worksheets 

d. It contains numbers, space,  

 alphabets, etc. : Text 

e. Another name of a worksheet. : Spreadsheet 

 

5. Answer the following questions: 

a. Why is MS Excel used for? 

Ans: 

MS Excel is used for storing, organizing and analyzing the 

information.  MS Excel is a spreadsheet program.  It is an 

electronic spreadsheet program where the data is stored in a 

tabular form consisting of rows and columns. 

 

MS Excel allows users to analyze and evaluate the changes in 

input.  It has added features of representing data in a chart form 

to help us easily analyze and understand the data. 

 

b. Differentiate between Workbook and Worksheet. 



Ans: 

The difference between Workbook and Worksheet is as 

follows: 

Workbook  : MS Excel files are called Workbooks.  Each 

workbook holds one or more worksheets. 

Worksheet : Worksheet is also called spreadsheet in 

which we work. These worksheets appear by 

default when we open an MS Excel 

workbook.  A worksheet has 10,48,576 rows 

and 16,384 columns.  Rows are identified by 

number from top to bottom along the left 

edge of the worksheet as 1, 2, 3, ….. .  

Columns are identified by letters from left to 

right as A, B, C, D, ….. . 

 

c. Write down the features of AutoFill. 

Ans: 

The features of AutoFill are as follows: 

1. To quickly fill in several types of data series, we select 

cells and drag the Fill Handle. 

2. To use Fill Handle, we select the cells that we want to 

use as a basis for filling additional cells and then drag the 

Fill Handle across or down the cells we want to fill. 

3. To fill a series of data, we fill in the first two cells in the 

series and then click on ‘Auto Fill’. 

4. We can repeat the same data in all cells like adjacent 

figure.  For this, we have to type the data in one cell and 

then drag Fill Handle for entire range. 

 

d. What is Undo and Redo? 

Ans: 

The Undo and Redo commands are as follows: 

Undo : Undo command is used to reverse almost every 

action in Excel. 

Redo : Redo command can again reverse back the action 

done with undo in MS Excel. 

 

e. Which types of data are used in Excel? 

Ans: 



In MS Excel, the worksheet consists of a grid of columns and 

rows that form cells. We enter three types of data in cells: 

Labels, Values and Formulas as follows: 

1. Labels : Labels (Text) are descriptive pieces of 

information such as names, months, or 

other identifying statistics and they 

usually include alphabetic characters. 

2. Values  : Values (Numbers) are generally raw 

numbers or dates. 

3. Formulas : Formulas are instructions for MS Excel 

to perform calculations. 

Activity Time 

Do it yourself. 

5. Learning PowerPoint 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. This software is a powerful tool for communicating ideas and 

information. 

(i) Spreadsheet 

(ii) Documentation 

(iii) Presentation  [  ✓ ] 

 

b. It is used to type text and place images. 

(i) Working space [  ✓ ] 

(ii) Reading View 

(iii) Notes Page View 

 

c. This view allows us to see all the Slides in smaller size. 

(i) Slide Sorter View [  ✓ ] 

(ii) Slide Show 

(iii) Reading View 

 

d. This view allows us to see how the note’s pages will be printed. 

(i) Notes Page View [  ✓ ] 

(ii) Slide Show 

(iii) Reading View 

 

2. Fill in the blanks: 



Ans:    

a. PowerPoint is used to make Presentations. 

b. Slide is the main screen of the PowerPoint Window. 

c. Outline Pane is used to organize the Slides of the Presentation. 

d. Slide Show View displays the slides on full computer screen. 

e. SmartArt Graphics is used to add visuals to slides that contain text. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Notes Page View displays the slides on  

 full computer screen. : [ F ]  

b. Normal View appears on the slide if we  

 have not selected a slide view. : [ T ] 

c. PowerPoint is the most powerful tool for  

 communicating ideas and information. : [ T ] 

d. The Slide Pane is used to organize the  

 Slides of the Presentation. : [ F ] 

e. A Placeholder consists of boxes with  

 dotted lines. : [ T ] 

 

4. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Slide  (iii) Pages in a Presentation.  

b. Notes Pane (iv) Add information to share with 

the audience.  

c. Placeholders (v) Boxes with dotted lines.  

d. Slide Layout (ii) Arranges the slide contents. 

e. SmartArt (i) It helps to create organization 

diagram. 

5. Answer the following questions: 

a. What is the importance of a Presentation? 

Ans: 

A Presentation is a creative step-wise delivery of information.  

It consists of a number of individual pages or ‘Slides’.  

Presentation is basically a simple way of displaying and 

explaining the contents of a topic to the audience.  It is done on 

Slides with the help of Text, Graphics, Movie, Sounds, etc.  

 



The importance of a Presentation is very important.  Some of 

the highlights of Presentation are as follows: 

1. Presentation helps us make our point. 

2. Presentation helps us present more easily. 

3. Presentation helps us feel confident and reduce our 

anxiety, 

4. Presentation helps us engage the audience so that they 

can enjoy the Presentation. 

5. Presentation helps increase our ability to influence. 

 

b. What is the use of Placeholder? 

Ans: 

Placeholder is used to store file like a container in Layouts that 

hold such content as text including Body Text, Bulleted Lists 

and Titles, Tables, Charts, SmartArt Graphics, Movies, Sounds, 

Pictures and ClipArt. 

 

On a new slide, boxes with dotted lines are called placeholders.  

There are different types of placeholders as follows: 

1. Title : A text box is formatted for a title. 

2. Text : A text box is used for bulleted lists. 

3. Contents : Located in the middle of the default 

slide.  

 

c. What is the use of Outline Pane? 

Ans: 

The Outline Pane is used to organize the Slides of the 

Presentation. 

 

d. What do you mean by Alignment? 

Ans: 

Alignment means to change the position of the text.  To change 

the alignment, we follow the following steps: 

1. Select the text of the placeholder. 

2. Click on the Home tab. 

3. Click on the desired alignment in the Paragraph group to 

align the selected text. 

Activity Time 

Do it yourself. 

6. More About  



Windows 10 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. It is designed for both touch and mouse users. 

(i) Windows 10  [  ✓ ] 

(ii) Windows 7 

(iii) Windows 8.1 

 

b. It is enhanced with resizable tiles and other new capabilities to help 

you to be more productive. 

(i) File Menu 

(ii) Start Menu  [  ✓ ] 

(iii) Task Menu 

 

c. In the right pane of the Start Men, you’ll find this for some common 

Apps. 

(i) Apps 

(ii) Files 

(iii) Tiles [  ✓ ] 

 

d. This menu provides access to advanced system tools. 

(i) Virtual Desktop 

(ii) Start Menu 

(iii) Quick Access [  ✓ ] 

 

2. Fill in the blanks: 

Ans:    

a. From the Start Menu, you can lock your computer, change your 

account settings or sign out. 

b. To display the Start menu, press Windows Logo Key on the keyboard. 

c. In the left pane of the Start menu, you’ll find File Explorer and 

Settings. 

d. You can drag Tiles to rearrange them within the right pane of the Start 

menu. 

e. Many users know that they can press Alt + Tab to switch between 

running Apps. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 



Ans:  

a. From the Start menu, you can quickly  

 access your Apps, documents, pictures  

 and settings. : [ T ] 

b. You can also drag Apps between the  

 Tile View on the File List View. : [ F ]  

c. Right-click a Tile to display a menu for  

 performing other actions with that tile. : [ T ] 

d. Tiles in the Start menu are divided by  

 Fields. : [ F ] 

e. To switch between Open Apps, you  

 use the Task View. : [ T ] 

 

4. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Windows 10 (iii) Most popular operating system.  

b. Start Menu (ii) Windows logo key + Tab 

c. Switch between Apps (iv) Quickly Access your Apps. 

d. Display the Task View (v) Alt + Tab  

e. Display Quick Access Menu (i) Windows logo key + X  

 

5. Answer the following questions: 

a. Write a short note on Windows 10. 

Ans: 

Windows 10 is designed to please both touch and mouse users.  

It is also designed to be an intuitive for users of both Windows 

7 and Windows 8.1 incorporating the best of both of them to 

enhance our experience and assist us to be more productive. 

 

b. What are Tiles? 

Ans: 

Tiles are shortcuts for Windows 10 Apps available in the 

Microsoft Store.  If we click on a Windows Tile, the respective 

app is launched.   In the right pane of Start Menu, we find Tiles 

for some common Apps.  Tiles in Start Menu are divided by 

category.   

 

c. What is the use of Quick Access Menu? 

Ans: 



Quick Access Menu provides access to advanced system tools 

such as: 

1. Power Options 

2. Device Management 

3. Command Prompt 

4. Task Manager  

5. Control Panel.  

 

To display Quick Access menu, we do the following: 

1. Right-click Start button. 

2. Press Windows Logo key + x on keyboard. 

 

d. Write the working of Task View. 

Ans: 

Some users press Alt + Tab to switch between running Apps.  

In Windows 10, we add a Task View button to Windows 

Taskbar to make this feature more discoverable.  Virtual 

desktops are also managed through Task View. 

 

To display Task View, we: 

• Select the Task View button on Windows Taskbar. 

Or 

• Press Windows Logo Key + Tab on keyboard. 

 

To switch between Open Apps using the Task View, we: 

• Select the Thumbnail for App we want within Task 

View. 

 

e. How will you display the Start Menu? 

Ans: 

We will display Start Menu by: 

• Selecting the Start button present on the far left of the 

Windows Taskbar. 

Or 

• Press Windows Logo Key from the keyboard. 

 

From Start Menu, we can: 

1. Lock our computer, change our account setting or sign 

out. 



2. Quickly access our Apps (both traditional Win 32 and 

modern), documents, pictures and settings. 

3. Shut down our computer, restart it or put it to sleep 

mode. 

4. Search for Apps, settings and files and search across the 

web. 

5. Immediately launch advanced system tools such as power 

options and Disk Management. 

Activity Time 

Do it yourself. 

7. Get Familiar with  

Internet 

 

EXERCISE 

1. Tick (✓) the correct option: 

Ans:  

a. In an E-Mail address readandrise@gmail.com, readandrise is a 

……………………. . 

(i) server name 

(ii) user name [  ✓ ] 

(iii) host name 

(iv) website 

 

b. Which is the correct E-Mail address? 

(i) readandrise@gmail.com [  ✓ ] 

(ii) d://file/index.html 

(iii) http://wwe. readandrise.com 

(iv) http://cbse.nic.in 

 

c. The E-Mail account is also called the ……………………. . 

(i) E-Mail site 

(ii) E-Mail password 

(iii) E-Mail ID [  ✓ ] 

(iv) Mail book 

 

d. What is one of the fastest modes of communication these days? 

(i) Courier 

(ii) Post 

(iii) E-Mail [  ✓ ] 

(iv) Telegraph 

mailto:readandrise@gmail.com
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2. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Google Chrome is a web browser. : [ T ] 

b. Downloading means saving a page from  

 the web to the computer. : [ T ] 

c. Graphics and Images cannot be used in  

 Multimedia. : [ F ] 

d. An E-Mail address defines the location of  

 an individual’s mailbox on the Internet.  : [ T ] 

e. Internet is the smallest network of  

 computers in the world. : [ F ] 

 

3. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. HTML (iv) Computer language.  

b. Website (iii) Collection of web pages. 

c. URL (i) The address of website.  

d. Surfing (ii) Using the Internet.  

 

4. Fill in the blanks: 

Ans:    

a. Uploading is moving a file from computer to the www. 

b. E-Mail is the most commonly used service on net. 

c. A Web Browser is used to read the web pages on the www. 

d. The E-Mail ID cannot contain spaces. 

 

5. Write short notes on the following topics: 

Ans:    

a. Surfing : When we look for any useful material in 

different websites and change from one to 

other, this is called ‘Surfing’.  Therefore, the 

process of moving from one website to 

another on the www is known as ‘Surfing’. 

Like we flip through the pages of a book, we 

surf from one web page to another searching 

for information.   

b. Web Browser : Web browser is software which enables us 

to browse through Internet like Microsoft 



Internet Explorer, Google Chrome and 

Mozilla Firefox. Internet Explorer is a free 

browser that comes with Windows.  Desktop 

has its icon and double-clicking on this 

launches Internet Explorer.  A Web Browser 

is used to read web pages on World Wide 

Web (www). 

c. Website : A Website is a collection of Web Pages 

linked together.  It is also commonly called 

a site.  The Website is like a book.  Just as a 

book has many pages, a Website is also 

made by many Webpages. 

d. Uploading : When we write, draw and create anything, 

we shift it to the World Wide Web (www).  

This is called ‘Uploading’.  Therefore, 

uploading a file is moving a page from our 

computer onto the World Wide Web.  An 

updated file is stored on a web server.  It can 

be seen and used all over the world 

simultaneously by innumerable people. 

 

6. Answer the following questions: 

a. Write about E-Mail ID. 

Ans: 

E-Mail ID is an E-Mail address which defines the location of an 

individual’s mailbox on the Internet.  The E-Mail ID consists of 

two parts separated by @ symbol.  The E-Mail ID does not 

contain spaces. 

 

Some examples of E-Mail ID are mentioned below: 

• bhaskar360@gmail.com 

• komal@gmail.com 

• shreyas@yahoo.com 

 

b. Write any two advantages of Internet. 

Ans: 

Two advantages of Internet are as follows: 

1. Searching information 

2. Communication 
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c. Write the components of Gmail. 

Ans: 

The components of Gmail are as follows: 

1. Subject is a description of topic of message and displays 

in a Gmail system that list e-mail messages individually. 

2. Sender (From).  This is sender’s Internet e-mail address. 

3. Date and Time received. (On) 

4. Reply-to 

5. Recipient (To:_ 

6. Recipient E-Mail Address 

7. Attachments. 

 

d. Write any two advantages of an E-Mail. 

Ans: 

Two advantages of an E-Mail are as follows: 

1. It is fast : The messages can be sent anywhere 

around the world within some seconds 

only. 

2. It’s economical : The cost of its service is costless and 

easily available. 

Activity Time 

Do it yourself. 

Model Test Paper - 1 

Chapters 1 to 4 

 

1. Tick (✓) the correct option: 

Ans: 

a. It controls the internal computer operation. 

(i) System software  [  ✓ ] 

(ii) Operating System 

(iii) Utility Software 

 

b. What is a Table made up of? 

(i) Columns 

(ii) Rows 

(iii) Both (i) and (ii) [  ✓ ] 

(iv) None of them 

 

c. Which group has Find button? 

(i) Editing [  ✓ ] 



(ii) Styles 

(iii) Font 

(iv) Paragraph 

 

d. What is called to make text slightly low on the line? 

(i) Subscript [  ✓ ] 

(ii) Superscript 

(iii) Both (i) and (ii) 

(iv) None of them 

 

2. Fill in the blanks: 

Ans:    

b. An open source software is one which may be available free of 

cost. 

b. It serves as an interface between the user and the hardware. 

c. An open source software is one which may be available free of 

cost. 

d. Arrow keys allow us to move left, right, up and down. 

e. Click on Auto Fit to adjust table width automatically. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. A computer cannot run without an  

 Operating System. : [ T ] 

b. A DBMS can store details about the  

 customers, employees, products and so on. : [ T ] 

c. Portrait or Landscape are net computer  

 terms. : [ T ] 

d. To put text at the bottom of the page, we  

 create Footer. : [ T ] 

e. We can create a table manually. : [ T ] 

 

4. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Word Processors (iv) MS Word  

b. Presentation Tool (iii) MS PowerPoint 

c. Spreadsheet Package (ii) MS Excel  

d. Business software (i) Payroll System 

 



5. Answer the following questions: 

a. Differentiate hardware and software. 

Ans: 

Difference between hardware and software is as follows: 

Hardware  : Physical parts of a computer are called 

Hardware.  We can see and touch all hardware 

parts.  Hardware can be classified into (i) Input 

Devices (ii) Processing unit and (iii) Output 

devices.  Hardware is the item used to define 

various parts of a computer.   

 

  Hardware devices are performers of commands 

given by software applications.  Some 

computer hardware devices are: 

1. Monitor 

2. CPU 

3. Mouse 

4. Keyboard 

 

Software : Computer software cannot be touched.  It can 

be seen in the form of icons (symbols) when 

installed in computer.  Software are programs 

written for hardware to work.  Examples are: 

1. Note Pad 

2. MS-Paint 

3. MS-Word 

4. MS-Excel, etc. 

 

b. What is the use of Spreadsheet Software? 

Ans: 

Spreadsheet Software accepts data values in row and columns 

format to allow users to manipulate, calculate and analyze data 

in the desired manner. 

 

Examples of Spreadsheet Software are: 

1. Excel 

2. Lotus 1-2-3 

3. Open Office.org Calc. 

4. Spreadsheet Software 

 



c. What is copy formatting? 

Ans: 

The user has to format the text after having written the same.  

The user can format text in the manner he wants.  If he likes 

another portion of document to have the same formatting, he 

can copy the formatting.  To copy formatting, the user follows 

these steps: 

1. Select text with formatting which user wishes to copy. 

2. Click Format Painter in Clipboard group on Home tab. 

3. The Mouse Pointer turns into a Paintbrush.  It looks 

strange. 

4. Apply the copied format by selecting text and clicking on 

it. 

Key Note: To apply format to more than one item, 

double-click on Format Painter button and 

apply the format. 

 

d. What do you mean by a Table? 

Ans: 

A Table is a grid of rows and columns that intersect to form 

cells.  It is easier to read or present information in Table Format 

than in paragraph format.   Using Word’s table feature, we can 

create a Table and insert text, pictures or another. 

 

e. How will you calculate the sum in a Table? 

Ans: 

We will calculate the sum in a Table by using SUM formula.  

Formula command is found under the Table Tools tab in the 

Data Group Layout tab.  It is done as follows: 

1. Select table cell where we want our result.  If cell is not 

empty, delete is contents. 

2. Click on Table Tools tab and then on Layout tab.  In the 

Data group, Click on Formula. 

3. Use the Formula dialog box to create the formula. 

Here we see that SUM (left) formula is already 

displayed.  

4. Click on OK button. 

 

6. Write the names of the following: 

Ans:    



1. Picture 1st   : Linux 

2. Picture 2nd   : Access 2013 

3. Picture 3rd  : Excel 2013 

4. Picture 4th  : Word 2013 

5. Picture 5th  : Android 

6. Picture 6th  : Adobe Photoshop  

 

Model Test Paper - 2 

Chapters 5 to 7 

 

1. Tick (✓) the correct option: 

Ans:  

a. This software is a powerful tool for communicating ideas and 

information. 

(i) Spreadsheet 

(ii) Documentation 

(iii) Presentation  [  ✓ ] 

 

b. This view allows us to see how the note’s pages will be printed. 

(i) Notes Page View [  ✓ ] 

(ii) Slide Show 

(iii) Reading View 

 

c. It is designed for both touch and mouse users. 

(i) Windows 10  [  ✓ ] 

(ii) Windows 7 

(iii) Windows 8.1 

 

2. Fill in the blanks: 

Ans:    

a. Outline Pane is used to organize the Slides of the Presentation. 

b. Slide Show View displays the slides on full computer screen. 

c. SmartArt Graphics is used to add visuals to slides that contain 

text. 

d. In the left pane of the Start menu, you’ll find File Explorer and 

Settings. 

 

3. Write ‘T’ for a true statement and ‘F’ for a false statement: 

Ans:  

a. Notes Page View displays the slides on  



 full computer screen. : [ F ]  

b. The Slide Pane is used to organize the  

 Slides of the Presentation. : [ F ] 

c. A Placeholder consists of boxes with  

 dotted lines. : [ T ] 

d. Tiles in the Start menu are divided by  

 Fields. : [ F ] 

e. To switch between Open Apps, you  

 use the Task View. : [ T ] 

f. You can also drag Apps between the  

 Tile View on the File List View. : [ F ]  

 

4. Match the following Columns: 

Ans: 

Column ‘I’     Column ‘II’ 

a. Windows 10 (iii) Most popular operating system.  

b. Start Menu (ii) Windows logo key + Tab 

c. Switch between Apps (iv) Quickly Access your Apps. 

d. Display the Task View (v) Alt + Tab  

e. Display Quick Access Menu (i) Windows logo key + X  

 

5. Write short notes on the following topics: 

Ans: 

a. Surfing : When we look for any useful material in 

different websites and change from one to 

other, this is called ‘Surfing’.  Therefore, the 

process of moving from one website to 

another on the www is known as ‘Surfing’. 

Like we flip through the pages of a book, we 

surf from one web page to another searching 

for information.   

b. Web Browser : Web browser is software which enables us 

to browse through Internet like Microsoft 

Internet Explorer, Google Chrome and 

Mozilla Firefox. Internet Explorer is a free 

browser that comes with Windows.  Desktop 

has its icon and double-clicking on this 

launches Internet Explorer.  A Web Browser 

is used to read web pages on World Wide 

Web (www). 



c. Website : A Website is a collection of Web Pages 

linked together.  It is also commonly called 

a site.  The Website is like a book.  Just as a 

book has many pages, a Website is also 

made by many Webpages. 

d. Uploading : When we write, draw and create anything, 

we shift it to the World Wide Web (www).  

This is called ‘Uploading’.  Therefore, 

uploading a file is moving a page from our 

computer onto the World Wide Web.  An 

updated file is stored on a web server.  It can 

be seen and used all over the world 

simultaneously by innumerable people. 

 

6. Answer the following questions: 

a. What is the importance of a Presentation? 

Ans: 

A Presentation is a creative step-wise delivery of information.  

It consists of a number of individual pages or ‘Slides’.  

Presentation is basically a simple way of displaying and 

explaining the contents of a topic to the audience.  It is done on 

Slides with the help of Text, Graphics, Movie, Sounds, etc.  

 

The importance of a Presentation is very important.  Some of 

the highlights of Presentation are as follows: 

1. Presentation helps us make our point. 

2. Presentation helps us present more easily. 

3. Presentation helps us feel confident and reduce our 

anxiety, 

4. Presentation helps us engage the audience so that they 

can enjoy the Presentation. 

5. Presentation helps increase our ability to influence. 

 

b. What is the use of Outline Pane? 

Ans: 

The Outline Pane is used to organize the Slides of the 

Presentation. 

 

c. What do you mean by Alignment? 

Ans: 



Alignment means to change the position of the text.  To change 

the alignment, we follow the following steps: 

1. Select the text of the placeholder. 

2. Click on the Home tab. 

3. Click on the desired alignment in the Paragraph group to 

align the selected text. 

 

d. Write the working of Task View. 

Ans: 

Some users press Alt + Tab to switch between running Apps.  

In Windows 10, we add a Task View button to Windows 

Taskbar to make this feature more discoverable.  Virtual 

desktops are also managed through Task View. 

 

To display Task View, we: 

• Select the Task View button on Windows Taskbar. 

Or 

• Press Windows Logo Key + Tab on keyboard. 

 

To switch between Open Apps using the Task View, we: 

• Select the Thumbnail for App we want within Task 

View. 

 

e. How will you display the Start Menu? 

Ans: 

We will display Start Menu by: 

• Selecting the Start button present on the far left of the 

Windows Taskbar. 

Or 

• Press Windows Logo Key from the keyboard. 

 

From Start Menu, we can: 

1. Lock our computer, change our account setting or sign 

out. 

2. Quickly access our Apps (both traditional Win 32 and 

modern), documents, pictures and settings. 

3. Shut down our computer, restart it or put it to sleep 

mode. 

4. Search for Apps, settings and files and search across the 

web. 



5. Immediately launch advanced system tools such as power 

options and Disk Management. 

 

f. Write any two advantages of Internet. 

Ans: 

Two advantages of Internet are as follows: 

1. Searching information 

2. Communication 

 

g. Write the components of Gmail. 

Ans: 

The components of Gmail are as follows: 

1. Subject is a description of topic of message and displays 

in a Gmail system that list e-mail messages individually. 

2. Sender (From).  This is sender’s Internet e-mail address. 

3. Date and Time received. (On) 

4. Reply-to 

5. Recipient (To:) 

6. Recipient E-Mail Address 

7. Attachments. 

 

7. Do it yourself. 


